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Abstract 
SailBot is designed to assist sailors with disabilities steer a Sonar Sailboat. SailBot is a portable 
device that has multiple control methods that can be used to accommodate any sailor's 
disability. The assembly document will outline the process to manufacture, assemble, and test 
SailBot to ensure a high-end product for any one’s Boathouse. The document require 
supplemental material which can be found at the following link:  
 
https://drive.google.com/drive/folders/1B5rsa2N1b7W4Nt3J8BDgv_pewIhxQkwj?usp=sharing  
 

 

SailBot is mounted on the stern of the boat next to the tiller with a bracket that hugs the outside 
of the tiller. The controller straps onto the user's leg and is used to steer the boat. Control 
modules can be swapped out to match the preference of the user. 
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Figure 1: SailBot's Location in boat 

Setup 
BOM 
Below is a list of materials required to purchase for SailBot. Image descriptions can be found in 
the appendix and a complete list with URL’s can be found on the file share drive. 
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Table 1: SailBot Bill of Materials 

Electrical Setup 
All code developed for the SailBot system was developed using the free and open source               
Arduino IDE. This includes libraries which the SailBot’s code depends on to function properly.              
These libraries are part of the code packet and are required to run any of the code for the                   
SailBot system. The link to download the Arduino IDE is          
https://www.arduino.cc/en/main/software. Follow the directions on the web page to download          
the software and set it up. The required libraries are included in the code files supplied with the                  
download. 
 

Library Files 
Chrono-master 
CytronMotorDriver-maste
r 
Encoder 
TM1637-master 
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These libraries must be installed before the SailBot code is loaded onto the Arduino devices.  
 

● To do this, open the Arduino IDE software and select the “Sketch” tab from the toolbar at                 
the top of the window.  

● In the “Sketch” tab move to the “Include Library” option and then move to the “Add .ZIP                 
Library…” option and select it.  

● A new window will open, from here navigate to where you have saved the downloaded               
libraries and SailBot code and select one of the library files as listed above.  

● Do this process for all of the libraries, after which the SailBot code should function               
correctly when loaded onto the Arduino devices. 

 
To upload code to either Arduino device the TX, transmit, and RX, receive, wires must be                
disconnected first. If these wires are left connected, no code will be loaded onto the devices. 
 
HC-05 bluetooth modules must be paired before they can be used in the system. To do this                 
both HC-05 units are wired as shown in the diagrams below with the Tx pin of the arduino wired                   
to the Tx pin of the HC-05 and likewise for the Rx pins. This is different to the standard                   
operation of the HC-05. After the HC-05s have been wired as such, they can be powered and                 
the LED on the module should flash every two seconds to show that it is in AT command mode. 
 

 
Figure 2: Controller Setup Schematic 
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Figure 3: SailBot Setup Schematic 

After this, an empty sketch is loaded onto the Arduinos, starting with the Arduino Mega 2560                
Rev3.  
 

● Make sure the Tx and Rx pins are not connected while uploading. 
●  After the empty sketch is uploaded, open the Serial Monitor in the Arduino IDE, the               

button for this is located in the top right portion of the window below the minimize,                
restore, and close buttons.  
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● After the Serial Monitor window is opened, the options “Both NL & CR” and “38400 baud”                

must be selected from the two drop down menus in the bottom right of the Serial Monitor                 
window.  

● To configure the HC-05 connected to the Arduino Mega 2650 Rev3 the following             
commands must be entered in the text box at the top of the window: 

o The command “AT” is entered, the area below should respond with “OK”. If the              
area responds with “ERROR: (0)”, attempt to send the command “AT” again.  

o After that, enter the command “AT+UART?”, this should respond with          
“+UART:38400,0,0”. If this is any other number enter the command,          
“AT+UART=38400”.  

o The next command is, “AT+ROLE?”, the response should be “+ROLE:0” if not            
enter “AT+ROLE=0”.  

o The final command for this device is, “AT+ADDR?” with a response in the form              
“+ADDR:XXXX:XX:XXXXXX” where the “X”s are some combination of letters and          
numbers. Record these letters and numbers as they will be needed to finish             
setup of the other HC-05 device. 

 
To configure the other HC-05 to work with the Arduino Uno Rev3 an empty sketch must be                 
loaded onto the Arduino as before, ensuring the Tx and Rx pins are not connected. 
 

● After the empty sketch is uploaded, open the Serial Monitor in the Arduino IDE.  
● After the Serial Monitor window is opened, the options “Both NL & CR” and “38400 baud”                

must be selected as before. 
● The first command entered in the text box at the top of the Serial Monitor is “AT” which                  

should get the response “OK”. If the area responds with “ERROR: (0)”, attempt to send               
the command “AT” again.  

● The next command is “AT+UART?”, this should respond with “+UART:38400,0,0”. If this            
is any other number enter the command, “AT+UART=38400”.  

● Next enter the command “AT+ROLE=1”.  
● The next command is “AT+CMODE=0”.  
● The final command is “AT+BIND=XXXX,XX,XXXXXX” where the “X”s are the same           

combination of letters and numbers recorded earlier. This should complete the setup of             
the HC-05 for both of the Arduino devices. 
 

Mechanical Setup/ Manufacturing 
Drawings for SailBot can be found in the File Share drive.  

Assembly 
Controller Assembly 
Controller Assembly Contains three parts: 

1. Component Assembly 
2. Wiring 
3. Final Assembly 
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Component Assembly 
 
To assemble the control panel, mount the LED’s, servo, push buttons, and seven segment clock 
to the front panel as shown below. The push buttons can be secured from behind with a nut 
while the servo, seven segment clock, and leds can be press-fit in and sealed from behind with 
adhesive. Once the servo is installed place the servo arm onto it from the opposite side of the 
panel. 
 

 
Figure 4: Control Panel Assembly 

 
To finish the control panel assembly, glue in a half circle piece of clear acrylic along the blue 
dotted line shown above to seal the tiller position dial display.  
 
To assemble the controller bottom, simply secure the arduino to the bottom piece with double               
sided adhesive foam strips as shown below. 
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Figure 5: Controller Bottom 

To assemble the controller top first install the three male bullet connectors in the control module 
dock. Then install the tiller direction switch from the inside as shown below. Finally install the 
power switch and battery cover (M3 Bolt). 
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Each of the control modules uses a unique analog device that takes 5 volt power and ground 
input pins and outputs through a signal pin. To assemble control modules, place the three 
female bullet connectors to the front, screw on the front handle, and then mount the analog 
device inside before wiring it to the bullet connectors in the order shown.  
 

          
 

Controller Wiring 
Below is the controller wiring schematic used to connect the control panel outputs and bullet 
connector inputs to the arduino mounted on the bottom of the controller. It is best to wire 
everything and do a test run before completing the assembly to ensure that everything is done 
correctly before it becomes harder to access. 
 

11 



Assembly Document 
P20032 - SailBot for Accessible Sailing 

 

 
Figure 6: Controller Schematic 

 
The controller is powered by a standard 9V battery and communicates with the SailBot using 
the HC-05 bluetooth module (instructions to set up are found in the Setup Section). To begin 
electrical assembly and wiring,begin by placing the Arduino Uno prototype shield on top of the 
Arduino Uno. Ensure that all pins line up, and that each male pin on the shield is placed in its 
corresponding female pin on the Uno. This should be a snug fit.  
 
After the shield is placed on the Arduino Uno, the following wiring diagram is used to solder in                  
wires and electrical components onto the shield: 
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Figure 7: Controller Wiring Diagram 

The top view of the wiring diagram corresponds to the image below, which is the actual 
prototype shield that is placed on the Arduino Uno. Each square on the wiring diagram 
corresponds directly to a pin on the shield: 

 
Figure 8: Arduino Uno Prototype Shield 

 
● Any colored pair of blocks with a number inside (1k, 10k, 220, etc.) represents a resistor, 

and the number represents the resistor value.  
● Any solid red square or rectangle represents 5V. 
● Any solid orange square or rectangle represents 3V. 
● Any solid black square or rectangle represents GND. 
● Resistors with connections off the prototype shield are denoted with an ‘x’ next to them. 

Each ‘x’ is followed by a pin number on the Arduino Uno (13, 12, 3, etc.), which 
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corresponds to a connection as per the schematic (CBATT_LED, TBATT_LED, 
START/STOP, etc.)  

 
After resistors and wires are soldered onto the Arduino shield, solder the connections to their 
respective destinations on the shield for the feedback and timer buttons and battery LEDs. VIN 
and GND will be powered by a barrel connector, which is attached to the 9V battery.  
NOTE: Do NOT solder TX and RX (connections from pins 1 and 0) until code is uploaded onto 
the Arduino. Otherwise, the code will not upload.  
 
To load the code onto the Arduino Uno, complete the following steps: 
 

1. Plug in the Arduino Uno to a computer using a USB cable. 
2. Open up the Arduino IDE, and the SailBot_Controller_Master_REV_G file. 

a. Make sure that this file is being opened from a folder called 
SailBot_Controller_Master_REV_G, otherwise, it will not work. 

2. Go to the ‘Tools’ tab, hover over ‘port,’ and select whatever COM port that ‘Arduino Uno’ 
appears on. 

3. Go to ‘Tools’ again, hover over ‘board,’ and select ‘Arduino/Genuino Uno.’ 
4. In the upper-left corner of the screen, click on the check mark in the turquoise circle to 

compile and upload the code to the board. After a few seconds, the bottom of the screen 
should say ‘done uploading.’   

5. The code is now on the Arduino and the SailBot can be powered by the 9V battery for 
operation. Be sure to solder TX and RX (connections from pins 1 and 0) to their 
respective places on the HC-05 chip as per the schematic before use.  
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Final Assembly 
After finishing wiring and testing the controller can be fully assembled. Attach the completed 
front panel using M4 bolts as shown below. Then screw on the controller bottom using M5 bolts. 
Check to make sure everything is still functioning properly and the controller assembly is 
finished.  
 

 
Figure 9: Final Controller Assembly 
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Main SailBot Assembly 
Assemble the bottom part of the frame together. Make sure to use the connector brackets in 

each corner.  

  
Figure 10: Bottom Frame of SailBot (Colors denote matching parts) 

 
Roll the Lead Screw Adapter onto the lead screw (with the external threads facing the side with                 
a groove). Place the L bracket over the adapter and screw the adapter nut on with an adjustable                  
wrench. The lead screw sits into the bearings which slide in the plates on either side 
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Figure 11: Exploded view of lead screw assembly 

The clevis rod end has two 1/4” bearings pressed inside each end. The shoulder bolt holds the 
assembly to the bottom of the L bracket. The threaded rod mounts to the clevis. 

 

 
Figure 12: Mounting the threaded rob and tiller assembly to SailBot 
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Use the four screws and small spacers to mount the bearing support plate to the 2.3-inch 2020 
aluminum extrusions. This will be placed on either side of the lead screw. 

 

 
Figure 13: Bearing Support Assembly 

 
Slide the support bearing assembly into the frame extrusion at the same time as the lead screw. 

Make sure the belt is around the big pulley. 
 
Start by mounting the motor onto the motor plate and use the set screw to place the pulley onto 

the shaft. 

 
Figure 14: CIM mounting to Plate 
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Use the 1.125” standoffs and mount the plate to the 40/20 frame. Wrap the belt around the 

motor pulley. Pull the motor up to tighten the belt before screwing in the bolts. 

 
 

 
 

Slide the top extrusions to fully enclose the SailBot frame. 
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Place the front lexan on the inner side of the aluminum extrusion. This will be used for the 
electronics cover. 

 

 
 
Slide the 3D printed extrusions onto the corners of each piece. Lock the extrusions in place with 

T nuts on either side 
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Bolt the lexan plates on the printed extrusions. 
 

 
 

The back lexan plate will contain the electronics 
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Cover the outer frame in Fiberglass. See the next section for fiberglass steps. 
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Bolt the hinges from the printed cover to seal the top of SailBot 
 

 
 

Fiberglass Casing 
The fiberglass case is made by laminating resin and fiberglass fabric over 3D printed corners 
and lexan walls. This process is best completed in a ventilated area, since the fumes and dust 
released are irritating and toxic. Each layer takes 3 hours to harden 
 
Fiberglass Materials: 

● Fiberglass fabric 
● Fiberglass resin and hardener 
● Cups (non waxed) and mixing for mixing resin 
● Disposable brushes 
● Gloves, mask, and safety glasses 
● 150 grit sandpaper  

 
Fiberglass Process: 

1. Prep surface by washing gently with warm soapy water and letting it air dry. This will 
clean off dust and other particles that could prevent the resin from adhering to the 
surface. 

2. Use instructions on the resin container to mix the appropriate amount of hardener with 
the resin. Once you mix them the resin will be workable for eight minutes. 

3. Paint a thin coat of resin onto the surface with the disposable brush. Place fiberglass 
fabric, cut to shape, on top of the resin, adhering it to the surface. Use the brush to 
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saturate the fiberglass fabric completely. Cover as much area and layer sheets of 
fiberglass fabric until eight minutes have passed and the resin is tacky. Place the 
fiberglass coated part in a clean, dry place and wait 3 hours for it to harden.  

4. If the part is not completely covered in fiberglass, repeat steps 2-3 until the piece is 
covered. The fiberglass should evenly cover the surface of the case and the walls should 
be rigid.  

5. Using the 150 grit sandpaper sand away rough edges and uneven spots. Wear a dust 
mask, gloves, and safety glasses and sand in a well ventilated area.  

 
Gel Coat Materials: 

● Marine grade gel coat, white, containing wax 
● Disposable brushes 

 
Gel Coat Process 

1. Sand and clean the surface of the fiberglass resin with warm soapy water. Let air dry 
before beginning to coat. 

2. Brush the gel coat evenly onto the fiberglass. Similar to the resin there is an 8 minute 
working period before the gel coat starts to harden. Cover as much as possible during 
the working time and let the case sit in a clean, dry place until the gel coat hardens. 

3. If the entire case was not covered with the first layer of gel coat, repeat step 2 until the 
entire case is covered. Apply in even layers for consistent finish.  

4. Let the gel coat harden for 24 hours or until the gel coat is no longer tacky. Paint more 
layers of gel coat if necessary for an even finish. 

 
Tips: 

● Always practice proper safety with a mask, gloves, and safety glasses. Clean all 
surfaces thoroughly with soap and warm water to get rid of toxic particles. 

● If the resin has turned tacky, sticky, and too thick to work with, wait for the case to 
harden completely and try a new layer.  

● The fiberglass fabric will resemble loose fiberglass when you layer it with the resin. Keep 
dabbing with the brush to soak the fiberglass fabric. Brushing works at first but will pull 
the fiberglass fabric away from the surface if not done carefully.  

● Working with a partner is helpful to cover more surface during the short working time 
period.  

● Fiberglass can be sanded from unwanted areas fairly easily with a coarse grit 
sandpaper, so don’t worry if some goes where it’s not supposed to.  

● Always clean the surface thoroughly. Dust particles will prevent the fiberglass and gel 
coat from adhering properly to the surface.  

● The cleaner and more precise the layers are in the beginning the better the end product 
will be. Take the time to sand in between layers and cut fiberglass sheets before mixing 
the resin. Planning ahead will pay off with a better end product. 

 

Electrical Assembly 
The following figure depicts the schematic of the slave portion of the electronics, which controls               
the actual SailBot, used to move the tiller:  
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SailBot Schematic 

 
The slave is composed of three primary components:  
 
1). The motor, which is controlled using a motor driver board, which is controlled by the                
microcontroller. This component is depicted in the upper-left of the schematic, with the driver              
board labeled ‘30A 5V-30V DC Motor Driver’ and the motor, depicted by ‘M,’ attached to the                
power terminals. 
 
2). The microcontroller (Arduino Mega 2560 Rev3), which controls the motor driver, collects             
information on motor position and SailBot battery life, and provides feedback (via the HC-05              
Bluetooth chip) to the controller for tiller position and SailBot battery life. This component is               
depicted by the large rectangular block in the center of the schematic, labeled ‘Arduino              
Mega2560 REV3,’ with all surrounding electronics. 
 
3). The battey, which provides power to the motor driver and the microcontroller. This includes               
the battery life monitor. This component is above the motor, depicted by ‘12V BATTERY.’ The               
green lines represent 6 gauge wire to come directly from the battery terminals. The orange lines                
represent 16 or 18 gauge wire to supply power to the motor driver board and the                
microcontroller. Intersections between the green and orange lines represent a connection using            
a terminal block.  
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To assemble the SailBot electrical system, begin by placing the Arduino Mega prototype shield              
on top of the Arduino Mega. Ensure that all pins line up, and that each male pin on the shield is                     
placed in its corresponding female pin on the Mega. This should be a snug fit.  
 
After the shield is placed on the Arduino Mega, the following wiring diagram is used to solder in                  
wires and electrical components onto the shield:  
 

 
SailBot Wiring Diagram 

 
The top view of the wiring diagram corresponds to the image below, which is the actual 
prototype shield that is placed on the Arduino Mega. Each square on the wiring diagram 
corresponds directly to a pin on the shield: 
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Figure 15: Arduino Mega Prototype Shield 

● Any colored pair of blocks with a number inside (1k, 10k, 220, etc.) represents a resistor, 
and the number represents the resistor value.  

● Any solid red square or rectangle represents 5V. 
● Any solid black square or rectangle represents GND. 
● Resistors with connections off the prototype shield are denoted with an ‘x’ next to them. 

Each ‘x’ is followed by a pin number on the Arduino Mega (2, 18, 19, etc.), which 
corresponds to an off-board connection as per the schematic (L_LIMIT, C_LIMIT, 
R_LIMIT, etc.)  

 
After resistors and wires are soldered onto the Arduino shield, solder the off-board connections 
to their respective destinations on the motor driver, encoder, hall effect sensor switches, and 
10-segment LED bar as per the schematic. For the VIN pin and the GND pin directly above it, 
screw the connections into a terminal block to the respective positive and negative battery 
wires.  
NOTE: Do NOT solder TX and RX (connections from pins 14 and 15) until code is uploaded 
onto the Arduino. Otherwise, the code will not upload.  
 
To load the code onto the Arduino Mega, complete the following steps: 
 

1. Plug in the Arduino Mega to a computer using a USB cable. 
2. Open up the Arduino IDE, and the SailBot_Tiller_Slave_REV_G file. 
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a. Make sure that this file is being opened from a folder called 

SailBot_Tiller_Slave_REV_G, otherwise, it will not work. 
2. Go to the ‘Tools’ tab, hover over ‘port,’ and select whatever COM port that ‘Arduino 

Mega 2560’ appears on. 
3. Go to ‘Tools’ again, hover over ‘board,’ and select ‘Arduino/Genuino Mega or Mega 

2560.’ 
4. In the upper-left corner of the screen, click on the check mark in the turquoise circle to 

compile and upload the code to the board. After a few seconds, the bottom of the screen 
should say ‘done uploading.’   

5. The code is now on the Arduino and the SailBot can be powered by the 12V battery for 
operation. Be sure to solder TX and RX (connections from pins 14 and 15) to their 
respective places on the HC-05 chip as per the schematic before use. 

Testing 
The following test plans were created to test all of the customer and engineering requirements. 
Required equipment, materials and an outline for the procedure and data collection strategy are 
detailed for each test. Refer to the Requirements and Testing document for the full test outline 
and referenced requirements. 
 

 
Figure 16: Force Test 
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Figure 17: Battery Life Test 

 

 
Figure 18: Water-proof Test 
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Figure 19: General Use Test 

 

 
Figure 20: User Test 
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Figure 21: Override Test 

 

 
Figure 22: Installation Test 
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